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This guide was created by the staff of the GIS/Data Center at Rice University and is to be used
for individual educational purposes only. The exercises outlined in this guide require access to
particular software and datasets which are available at Fondren Library.
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Obtaining the Tutorial Data

Before beginning the tutorial, you will copy all of the required tutorial data onto your Desktop.
Follow the applicable set of instructions below depending on the particular computer you are
using.

Accessing tutorial data from Fondren Library using the gistrain profile

If you are completing this tutorial from a public computer in Fondren Library and are logged on
using the gistrain profile, follow the instructions below:

1. On the Desktop, double-click the Computer icon - gisdata (\\fon-gis04) (O:) >
Short_Courses - Manipulating_Data_In_ArcGIS_Series >
Data_Interpolation_and_Extraction.

1. To create a personal copy of the tutorial data, drag the InterpolationTutorialData
folder onto the Desktop.

2. Close all windows.
Accessing tutorial data online using a personal computer

If you are completing this tutorial from a personal computer, you will need to download the
tutorial data online by following the instructions below:

1. Using aweb browser, go to the Data Manipulation and Extraction short course
webpage at: http://library.rice.edu/gis-interpolation

2. At the bottom of the webpage, under the Resources section, click the Data
Interpolation and Extraction — Tutorial Data link to download the tutorial data.

3. Unzip the InterpolationTutorialData folder.

4. Copy the unzipped InterpolationTutorialData folder to your Desktop or another
location of your choice. Ensure that you note the file path of the location you have
selected.

Any time throughout the tutorial that you see reference to the file path
C:\Users\gistrain\Desktop\InterpolationTutorialData, you will need to substitute it with the file
path you have just selected.

The following step-by-step instructions and screenshots are based on the Windows 7 operating
system with the Windows Classic desktop theme and ArcGIS for Desktop 10.1 software with an
Advanced license. If your personal system configuration varies, you may experience minor
differences from the instructions and screenshots.
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Scenario Description

Imagine that you work for an insurance agency and a hurricane has just hit Houston. You have
gathered data on rain and wind from the National Oceanic and Atmospheric Agency (NOAA) in
the form of rain gauge estimates of rainfall and a feature class depicting the peak average wind
speeds when the hurricane landed. Your company has several policy holders claiming that
damage was done to their homes during the course of the hurricane. Investigators have gone out
to the houses to document the damage, but the company needs to know what the hurricane
conditions were like at each house before awarding any claim money. However, none of the
houses in question lie directly at a rain gauge or a hurricane wind speed line, so you must
interpolate the data with the most accurate interpolation technique and extract the data so that it
IS in a convenient tabular format for your supervisor.

Preparing Data

Setting up a map document
You will begin by opening ArcMap and creating a new map document.
1. On the Desktop, double-click the ArcMap 10.1 icon.

2. Inthe 'ArcMap — Getting Started’” window, ensure that My Templates and the Blank
Map template are selected.

At the bottom of the window, notice the default geodatabase for this map is currently set to

C:\Users\gistrain\Documents\ArcGIS\Default.gdb. The default geodatabase should be set to the
geodatabase that will contain most of the data for the particular map document you are working
on. In this case, you will want to use the geodatabase in your InterpolationTutorialData folder.

3. Nextto the ‘Default geodatabase for this map:’ box, click the Browse button.

Default geodatabase for this map: What is this?
C:\Users'\gistrain\Documents\ArcGIS\Default.gdb v

4. In the ‘Default Geodatabase’ window, click the Connect To Folder button.

Look in: It.»j Home - Documents\ArcGIS _ﬂ @ oy 3| EE EIlL@®

5. Inthe ‘Connect To Folder” window, select the InterpolationTutorialData folder
located on the Desktop.

Ensure that the InterpolationTutorialData folder is highlighted in blue and not the
HurricaneData.gdb geodatabase that appears inside it. You never want to connect directly to a
geodatabase, as doing so will prevent you from being able to access any of the data contained
inside of it.
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6. For ‘Folder:’, verify that either the InterpolationTutorialData folder or the
C:\Users\gistrain\Desktop\InterpolationTutorialData filepath is listed and click OK.

7. In the ‘Default Geodatabase’ window, select the HurricaneData.gdb geodatabase
and click Add.

8. Ensure the ‘Default geodatabase for this map:’ box says
“C:\Users\gistrain\Desktop\interpolationTutorialData \HurricaneData.gdb” and
click OK.

At this point, it is a good idea to save your map document and to continue saving regularly.

9. On the Standard toolbar, click the Save button.

De@s - )8

10. In the ‘Save As’ window, use the ‘Save in:’ drop-down box to select your
InterpolationTutorialData folder.

You will save the map document here, directly inside the InterpolationTutorialData folder, but
NOT within the HurricaneData geodatabase.

11. For ‘File name:’, type “Hurricanelnvestigation” and click Save.

Remember that, in order for your GIS project to open properly on other computers, you must tell
the map document to store relative pathnames to its data sources and take your entire project
folder containing all of your data and your map document with you.

12. Click the File menu and select Map Document Properties....

13. Towards the bottom of the ‘Map Document Properties’ window, click the checkbox
to ‘Store relative pathnames to data sources’ and click OK.

14. On the Standard toolbar, click Save again to store this setting in your map
document.

Adding feature class data to your map document
1. On theright side of the ArcMap window, click the Catalog tab.

2. On the Catalog toolbar, click the Go To Default Geodatabase button, which will
take you to the geodatabase you specified earlier.

c-oe@Ealk

3. Double-click the HurricaneData geodatabase to expand its contents.
4. Drag the Texas feature class into the Map Display.

A rough outline of the state of Texas appears in your Map Display window.
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5. Again, click the Catalog tab and drag the Hurricane feature class into the Map
Display.

The rings represent the particular wind speed readings for the hurricane.

6. Inthe Table of Contents, right-click the Hurricane layer and select Open Attribute
Table.

Notice that there is a Windspeed attribute that tells you the peak average wind speed along each
ring when the hurricane landed. The wind speeds varied from 95 to 120 miles per hour.

7. Close the attribute table.

Adding tabular data to your map document
1. Ontheright side of the ArcMap window, click the Catalog tab.
2. Double-click the Houses Excel file to expand it and view its individual worksheets.

Remember that ArcMap can only add one worksheet within an Excel file at a time, so you will
need to specify which worksheet you wish to add. In most cases, you will be interested in the
first worksheet.

3. Under the Houses Excel file, drag the Sheetl$ worksheet into the Map Display.

Notice at the top of the Table of Contents, the highlighted icon has switched from the first “List
By Drawing Order’ button to the second ‘List by Source’ button. That switch is because the
tabular data you just added does not have a graphic component, so it cannot yet be drawn and
will not appear in the drawing order view. While the “List by Drawing Order’ button shows the
names of the layers and allows you to reorder them, the “List by Source’ button must be selected
in order to see tables.

Table Of Contents

4. Again, click the Catalog tab and double-click the Rainfall Excel file to expand it
and view its individual worksheets.

5. Under the Rainfall Excel file, drag the Sheetl$ worksheet into the Map Display.

Because both of the individual Excel worksheets were not renamed, they are both listed as
Sheet1$ in the Table of Contents.
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6. Hover over the right edge of the Table of Contents until your cursor turns into a
double-sided arrow.

7. Click and drag the right edge of the Table of Contents to the right until you can

see the full file paths, as shown below.

Table Of Contents e
%:[8]S 8| i
=l = Layers
& (3 C:\users\gistrain\Desktop\Working_data\Data\HurricaneData.gdp
= M Hurricane

= @ Neighborhood
(I
= M Texas
]
= £ ¢:\Users\gistrain\Desktop\Working_data\Data\Houses. xls
B3 Sheet1s
5 B3 C:\Users\gistrain\Desktop\Working_data\Data\Rainfall. xis V
653

Now you can see the name of the Excel file from which each Sheet1$ originated, but to avoid
further confusion, you will rename the Excel worksheet layers. This action will not rename the
worksheets in the actual Excel file, but only how they are listed in the Table of Contents in this
particular map document.

8. Underneath the Houses.xls file path, click the Sheet1$ table to select it.
9. Click the Sheetl$ table again to enable renaming and type “Houses”.
10. Underneath the Rainfall.xlIs file path, click the Sheetl$ table to select it.
11. Click the Sheetl$ table again to enable renaming and type “Rainfall”.

12. Ensure your Table of Contents appears as shown below.

Table Of Contents

';:Z@Q} @ |

=/ Layers

B |3 C:\Users\gistrain\Desktop\Working_data\Data\HurricaneData.gdb
= Hurricane

0]

= [ Neighborhood
O
= Texas
O
B £ C:\Users\gistrain\Desktop\Working_data\Data\Houses.xis
B3 Houses
B £ c:\Users\gistrain\Desktop\Working_data\Data'\Rainfall.xis

© B
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Now you will examine what data is contained in each of the two tables.
13. Right-click the Houses table and select Open.

Note that the Houses table includes the longitude and latitude of each house that has filed an
insurance claim.

14. Close the Houses table.
15. Right-click the Rainfall table and select Open.

Note that the Rainfall table includes the longitude and latitude of each rain gauge in the hurricane
area, as well as the inches of rainfall collected in each gauge during the hurricane.

16. Close the Rainfall table.

Mapping XY Data

Both the Houses and Rainfall tables include coordinates for the longitude and latitude of each
data point; however, in order to display this tabular data in a graphic format, you will need to
map these points based on their XY coordinates.

1. Inthe Table of Contents, right-click the Rainfall table and select Display XY
Data....

2. For ‘X Field:” select the Longitude field.

3. For ‘Y Field:” select the Latitude field.

Notice in the ‘Coordinate System of Input Coordinates’ box, it defaults to the particular
projection being displayed in our active data frame, which is currently
GCS_North_American_1983, or the North American Datum 1983, commonly abbreviated as
NAD 83. This is the particular geographic coordinate system of the original three feature classes
you added to the map display.

4. Inthe ‘Coordinate System of Input Coordinates’ box, click Edit....

5. Inthe ‘Spatial Reference Properties’ window, scroll down to the bottom of the list
of projections.

Because the coordinates are in the form of latitude and longitude in decimal degrees, you know
you will need to select a geographic coordinate system, rather than a projected coordinate
system. While the data could theoretically be in any geographic coordinate system, you will
select the World Geodetic System of 1984, commonly abbreviated WGS 84, because this is the
reference coordinate system used by the Global Positioning System (GPS). Under most
circumstances, this will be the best coordinate system to select when mapping latitude and
longitude coordinates.

6. Double-click the World folder.
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7. Select WGS 1984 and click OK.

8. Ensure your window matches that below and click OK.

— Spedfy the fields for the X, Y and Z coordinates:

X Field: |Longitude |
Y Field: !Laﬁ._-de EI
Z Field: |<None> 3
—Coordinate System of Input Coordinates ——————————
Description:
Geographic Coordinate System: =)

Name: GCS_WGS_1984

A warning message appears to let you know that the functionality of your data will be limited
until you export the data to a new layer.

9. Click OK.
Your Map Display now shows the location of each rain gauge as a point feature.

The locations of the points in the Rainfall table are currently stored in a temporary layer called
Sheet1$ Events. Since the points appear to be in reasonable locations, you will want to export the
temporary layer into a new permanent feature class in your default geodatabase. Exporting to a
feature class will allow you to manipulate these points and reuse them in other future map
documents without having to go through the display XY data process each time.

10. In the Table of Contents, right-click the Sheetl$ Events layer and select Data >
Export Data....

Notice that the output feature class defaults to your default geodatabase
(C:\Users\gistrain\Desktop\InterpolationTutorialData\HurricaneData.gdb).

11. For ‘Output feature class:’, scroll to the end and rename the feature class from
“Export_Output” to “Rainfall”.
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12. Ensure your ‘Export Data’ window appears as shown below and click OK.

x
Export: 'Al features ZI

Use the same coordinate system as:
(% this layer's source data
" the data frame

€ the feature dataset you export the data into
(only applies if you export to a feature dataset in & geodatabase)

Qutput feature dass:

Ilistlam\Desldop\h'lterpolation TutorialData\HumcaneData .gdb\Rainfall ﬁl

x| con

13. Click Yes to add the exported data to your map as a layer.

Since you have now created a permanent feature class, you may remove your temporary events
layer and the corresponding Excel table.

14.1n the Table of Contents, right-click the Sheetl$ Events layer and select Remove.

15.In the Table of Contents, right-click the Rainfall table and select Remove.

Now you will repeat the same process to create a permanent point feature class for the Houses
data table.

16. Repeat steps 1 - 15 using the Houses table. Rename the exported feature class
“Houses” and then remove the Houses table from the Table of Contents.

Your Map Display now shows the locations of all of the houses filing insurance claims due to the
hurricane and you have all the necessary layers added into your map document.

17. At the top of the Table of Contents, click the List by Drawing Order icon.

Table Of Contents q
SEECIE

18. Click and drag the right edge of the Table of Contents back to the left, so that it is
only wide enough to display the short layer names.
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Interpolating Data

Interpolation allows you to estimate the values of new data points based on the values of existing
data points. In this case, you would like to estimate the rainfall values at each of the house
locations based on the rainfall values recorded at each of the rain gauge locations. The following
section will teach you several methods of interpolating both point and line vector data into raster
datasets, which provide estimated values of the data variables across the entire region. You will
see how these different interpolation techniques lead to varying resulting raster datasets. It is
important to select an interpolation technique best suited to your existing data and your desired
analysis.

Activating ArcGIS Extensions

Many of the tools you will be using in this section require the EEEE 2
use of the 3D Analyst and Spatial Analyst extensions in onsibicdoredominthoaolin:
ArcGIS. By default, these extensions are not activated, so g m
you will need to activate them before you can make use of E] St g
their functionality. O ity Ao
B o
1. Click the Customize menu and select =ty
Extensions.... iy
O Tracking Analyst
2. Check 3D Analyst and Spatial Analyst to enable
the functions of those two extensions. e
30 Analyst 10.0
3. Ensure your ‘Extensions’ window appears like ::;?:ﬂf:;:t’;m
that to the right and click Close.

Point Interpolation B s

First you will interpolate the rainfall data, because point data is usually easier to interpolate to
raster data than line or polygon data. In this section, you will interpolate the rainfall data using
the Inverse Distance Weighted, Spline, Natural Neighbors, and TIN interpolation methods.

Since you are only interpolating the rainfall data at this point, you will temporarily turn off some
of the other layers.

1. Inthe Table of Contents, uncheck the Houses and Hurricane layers so that they
are no longer visible.

At this point, only the Rainfall and Texas layers should be visible.
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Inverse Distance Weighted Interpolation Method

1. On the Standard Toolbar, click the ArcToolbox window button.

EEEED g

2. In ArcToolbox, double-click the Spatial Analyst Tools toolbox.
3. Double-click the Interpolation toolset
4. Double-click the IDW (Inverse Distance Weighted) tool.

5. In the 'IDW’ window, use the ‘Input point features’ drop-down box to select the
Rainfall layer, which contains your rain gauge data points.

6. Usethe ‘Zvalue field’ drop-down box to select the Rainfall field that contains the
values you wish to interpolate.

7. For ‘Output raster’, rename the exported raster from “Idw_Rainfalll” to
“IDW_Rain”.

8. Leave the other fields with their default settings, ensure your ‘IDW’ window
appears as shown below, and click OK.

=101

Input point features
Rainfall R J j
Z value field
| Rainfall =~
Qm:ut raster

v:\Users\gistrain\Desktop \InterpolationTutorialData \HurricaneData.gdb \IDW_Rain J _I

[ ok | cancel | envionments... |  showHelp >> |

It will take several seconds for the tool to begin running, at which point you will see the name of
the tool in blue text scrolling across the bottom right portion of the ArcMap window in a white
box. When the tool has finished running, another gray box will pop up in the same corner with
the name of the tool and a green checkmark.

9. When the IDW tool has completed, close ArcToolbox.

Currently, you cannot see most of the newly interpolated raster layer, because it is beneath the
Texas layer.

10. Drag the IDW_Rain layer to the top of the Table of Contents window, above the
Houses layer, so that it is fully visible.
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Now you cannot see the interpolation points, because they are beneath the new raster layer. To
make them visible, you will make the raster layer transparent.

11. In the Table of Contents, double-click the IDW_Rain layer.
12. At the top of the ‘Layer Properties’ window, click the Display tab.
13. For ‘Transparency’ type “40” and click Apply.
Notice that you can now see the other layers beneath the raster layer in the Map Display window.

The raster layer is currently symbolized using nine classes; however, the values of the cells in the
raster are actually more continuous in nature, so you will symbolize them continuously, rather
than in classes.

14. At the top of the ‘Layer Properties’ window, click the Symbology tab.

15. On the left, for ‘Show:’ select Stretched.

Show:

Discrete Color

16. Use the ‘Color Ramp:’ drop-down box to select a blue color ramp and click OK.

You can now see the continuously interpolated raster containing rainfall values that were
generated using the data collected at the specific rain gauge points. Notice how this IDW method
results in distinct rings around each input data point.

17.In the Table of Contents, uncheck the IDW_Rain layer.

Spline Interpolation Method
1. On the Standard Toolbar, click the ArcToolbox window button.
2. Inthe Interpolation toolset, double-click the Spline tool.

3. Repeat steps 5-16 above in the Inverse Distance Weighted Interpolation Method
section on pages 11 and 12, but rename the raster output “Spline_Rain”.

Compare the result of the Spline interpolation to the result of the IDW interpolation by turning
each layer on and off in the Table of Contents. Since the layers are transparent, you need to
ensure that only one raster is turned on at a time. Notice how the Spline interpolation tries to
reduce the sharp edges and sudden jumps in data and does not exhibit the distinct rings around
the input points, as the IDW method does. The Spline interpolation process assumes that, overall,
there is a smooth transition in the data and tries to mirror that effect in its output.
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4. In the Table of Contents, uncheck the Spline_Rain layer and any other raster
layers you turned on.

Natural Neighbors Interpolation Method
1. On the Standard Toolbar, click the ArcToolbox window button.
2. Inthe Interpolation toolset, double-click the Natural Neighbor tool.

3. Repeat steps 5-16 above in the Inverse Distance Weighted Interpolation Method
section on pages 11 and 12, but rename the raster output “NN_Rain”.

Compare the result of the Natural Neighbors interpolation to the results of the previous two
interpolation methods. Note that it is smooth everywhere except for the distinct highs and lows
directly around the data points, though even at the data points it is smoother than in the IDW
interpolation method. Note also that the interpolation is limited to the area covered by the input
points, rather than a rectangle of the same extent.

4. In the Table of Contents, uncheck the NN_Rain layer and any other raster layers
you turned on.

TIN Interpolation Method

Using the Create TIN tool, you can create a TIN based on an existing feature class.

1. Onthe Standard Toolbar, click the ArcToolbox window button.

2. Double-click the Spatial Analyst Tools toolbox to collapse it.

3. Double-click 3D Analyst Tools > Data Management > TIN > Create TIN.

4. For ‘Output TIN’, type “TIN_Rain” and click elsewhere to update the text field.

Note that the output TIN is automatically located in your default geodatabase.

5. Ensure the ‘Output TIN’ box says
“C:\Users\gistrain\Desktop\InterpolationTutorialData\HurricaneData.gdb\
TIN_Rain”.

6. Usethe ‘Input Feature Class’ drop-down box to select the Rainfall feature class.

7. In the new Rainfall feature class row, use the ‘height_field’ drop-down box to
select the Rainfall field as shown below.
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8. Ensure your ‘Create TIN' window appears as shown below and click OK.

=Tk
Output TIN 2]
| C:\Users\gistrain\Desktop\Working_data\Data\HurricaneData.gdb\TIN_Rain =%
Spatial Reference (optional) T
[ o
Input Feature Class (optional)
[ | =)
in_feature dass | height fild | SF tyre | tag_field +
< Rainfal ~| masspoints <None> e
<None> x
Longitude =
Lattude L
jod
J |2
[ Constrained Delaunay (optional) #
OK Cancel | Env‘rommts...l Show Help >> I

This method interpolates the rainfall data points by defining the vertices of each triangle in the
TIN and interpolating across each triangle. From here, it is very simple to convert the TIN to a
raster, so that it is in the same format as your other interpolation layers.

9. In ArcToolbox, double-click the Data Management toolset to collapse it.

10. In the 3D Analyst Tools toolbox, double-click Conversion > From TIN > TIN to
Raster.

11. Use the ‘Input TIN' drop-down box to select the tin_rain TIN.

12. For ‘Output raster’, rename the exported raster from “tin_rain_Tin” to
“TINRast_Rain”.
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13. Ensure your ‘TIN to Raster’ window appears as shown below and click OK.

[(\TiNtoraster =10 |

1

Input TIN

I tin_rain Ll
Output Raster

| C:\Users\gistrain\Desktop\InterpolationTutorialData \HurricaneData.gdb \TINRast_Rain

Output Data Type (optional)
| FLOAT

Method (optional)

=i
|
| LNEAR |
|

|

Sampling Distance (optional)
| OBSERVATIONS 250

izFactor (optional)

1
=
| OK I Cancel Envirormmts...l stmvHeb>>I

14. When the TIN to Raster tool has completed, close ArcToolbox.

15. In the Table of Contents, uncheck the tin_rain layer to view the new raster layer
created from the TIN.

16. Repeat steps 11-16 above in the Inverse Distance Weighted Interpolation Method

section on page 12 to symbolize the TINRast_Rain layer as you did the other
raster layers.

Compare the results of the TIN interpolation to the results of the previous three interpolation
methods. Note that the triangulation method results in defined and continuous ridges and valleys,
which makes sense, because TIN files are most commonly used to represent land elevation.

Now you have explored four methods for interpolating the rainfall data, so you will turn off the
layers you have generated in this Point Interpolation section.

17.In the Table of Contents, uncheck all layers, except for the Texas layer.
Line Interpolation

You will now try interpolating the Hurricane line feature class using the same TIN-based
method you just used to interpolate the rainfall point data. Recall that the Hurricane feature class
contains a Windspeed field in its attribute table, which tells you the peak average wind speed
along each line at the time the hurricane landed.

1. Inthe Table of Contents, check the Hurricane layer to make it visible.

2. On the Standard Toolbar, click the ArcToolbox window button.
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Again,

layers.

9.

10.

In ArcToolbox navigate to 3D Analyst Tools > Data Management > TIN > Create
TIN.

For ‘Output TIN', type “TIN_Wind” and click elsewhere to update the text field.
Ensure the ‘Output TIN' box says

“C:\Users\gistrain\Desktop\IinterpolationTutorialData\HurricaneData.gdb\
TIN_Wind".

Use the ‘Input Feature Class’ drop-down box to select the Hurricane feature class.

In the new Hurricane feature class row, use the ‘height_field’ drop-down box to
select the Windspeed field as shown below.

Ensure your ‘Create TIN’ window appears as shown below and click OK.

—IDfx]
Output TIN =
| C:\Users\gistrain\Desktop\Working_data\Data\HurricaneData.gdb\TIN_Wind =%
Spatial Reference (optional) =
[ |
Input Feature Class (optional) )
| M=

in_feature dass | height field | SF_type | tag_field B
<> Hurricane +| hardine <None> pe—
x| =
Id
0 ‘-’.*'mdseed Environments... I Show Help >> |

you need to convert the TIN to a raster, so that it is comparable to the other interpolation

Repeat steps 9-16 above in the TIN Interpolation Method section on pages 14 and
15, but select tin_wind for the input TIN and name the output raster
“TINRast_Wind".

In the Table of Contents, click the minus sign next to all of the raster and TIN
layers to collapse their symbologies.
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Extracting Data

All of the raster interpolations you have created for wind and rain provide continuous value
estimates over the entire hurricane area, but you are only interested in the data values at the
particular locations of the individual houses filing insurance claims. You will extract point data
for each of the house locations from each of the five raster layers you just created in a database-
compatible format for the insurance company to use. Extracting data is one of the most important
aspects of data manipulation, since interpolation is useless if the results cannot be taken out of
GIS and used for other procedures.

Extracting Multi Values to Points

1.

2.

18

On the Standard Toolbar, click the ArcToolbox window button.

In ArcToolbox, double-click the 3D Analyst Tools toolbox to collapse it.
Double-click Spatial Analyst Tools > Extraction > Extract Multi Values to Points.
Use the ‘Input point features’ drop-down box to select the Houses layer.

Use the ‘Input rasters’ drop-down box to select all five interpolation rasters you
created earlier one at a time: IDW_Rain, Spline_Rain, NN_Rain, TINRast_Rain and
TINRast_Wind. The order in which the rasters are listed is the same order in which
the extracted value columns will appear in the output feature class attribute table.

Check Bilinear interpolation of values at point locations.

Ensure your ‘Extract Multi Values to Points’ window appears as shown below and
click OK.

_ioix
Input point features =
Input rasters
| =l F-3~|

Raster | Output field name .|.|
< 1DW_Ran IDW_Rain
< spline_Rain Spline_Rain X I
<NN_Rain NN_Rain
<> TINRast_Rain TINRast_Rain 1 I
< TINRast_Wind TINRast_Wind

4
< | »]

[V Bilinear interpolation of values at point locations (optional) E:J

[ ok | caxel | Envioments...| showrep>> |
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The Extract Multi Values to Points tool simply adds a field for the value of each raster to the end
of your existing Houses attribute table, which is why you were not asked for an output location.

8. Inthe Table of Contents, right-click the Houses layer and select Open Attribute

Table.
=
He - R EE X

OBJECTID* | Longitude | Latitude | Shape* | IDW_Rain | Spline_Rain | WN_Rain | TINRast_Rain | TiNRast_Wind |«
[ 1] -97.167361| 27.682308|Point | 4387905 580396 4498074 4.729097 | 99.141716
Ls 2| -97.720219| 28.121026|Point | 3279388 2502879| 3.383931| 3.567429| 96.349251
Lis 3| -97.729219| 28.841313|Point | 2758403 0.742849| 2.467795| 252352| 95.936554
Lis 4] -97.249024| 28.52118S|Point | 2913369 _0.8372| 2277198| _2.35161] 99.543404
L S| -96.808545| 26.121026|Point | 3254511 3.750495| 3.677428] 4272639 | 108.7739
B 6| -96.341383| 28.654575|Point | 368643 5.208400] 4.495143 4.522891 | 116.69263
IE| 7| -96:862118| 28974707 Point | 38338 3337146 32787865 3618719 107.35378
m 8| -96.995587| 29.214804|Point [ 0.615689| 1.847397 | 3.025707 99.252824 |
m 9| -57.235685| 29.561612|Point | 2612972 0.872767| 2.001626 1514181 96.505384 |
] 10| -95.168176| 30.041808|Point 4577866 | 5022193 4347685 4173294 96296957 | v |
4 4 1 n E (0 out of 15 Selected)
| Houses

Notice the five new fields added to the end of the existing attribute table which contain the
values of each of the five rasters at each house location. Notice also the differences in rainfall
estimates resulting from the four different interpolation techniques. At many house locations, the
value of the Spline interpolation is the most different from the other interpolation method values.

9. Close the attribute table.

You are now ready to export the data table into a format that can be used by the insurance
company without having to use ArcGIS software.

10. At the top left of the Attribute Table, click the Table Options button - and
select Export....

Exporting from the attribute table will export only a data table, rather than a complete feature
class, as you exported previously from the Table of Contents.

11. Use the ‘Export;’ drop-down box to select All records.

The output table location defaults to you default geodatabase, but a table saved inside a
geodatabase will not be accessible without ArcGIS, so you will need to save the table inside your
InterpolationTutorialData folder, but outside your HurricaneData geodatabase.

12. For ‘Output table:’, click the Browse button.

13. Use the ‘Look in:” drop-down box to select your
C:\Users\gistrain\Desktop\InterpolationTutorialData folder.

14. For ‘Name:’, replace “Export_Output” with “Houses_Rain_Wind".
15. Use the ‘Save as type:’ drop-down box to select Text File.
16. Ensure your ‘Saving Data’ window looks like that shown below and click Save.
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x
lookin: |7 C:\Users\gistrain\Desktop\inter v| & fwy 13 [EE v |E4 | EU L @
Houses.xls

B] Rainfall.xls

Name: | Houses_Rain_Wind. txt Save

S e Concel |

17. Click OK.
18. When asked if you want to add the new table to the current map, click No.

Now you have what the insurance company is looking for: a single text file containing the
locations of the houses in question, as well as the corresponding rainfall and wind speed
estimates to use in completing a damage quote for your customers.

19. Close the Houses attribute table.

Note that if you simply wanted a table containing the values of multiple rasters at each point and
did not care about symbolizing or working with the points any further in the ArcMap
environment, you could have used the Sample tool which outputs a separate table, rather than
adding the values to the end of your existing feature class attribute table.

Raster Calculations

Your final project involves working with the raster calculator. The raster calculator performs
calculations on a cell-by-cell basis and outputs the calculation results in a new output raster. You
will perform a simple calculation using the raster calculator, but the raster calculator can perform
many functions, such as adding or subtracting one raster from another, multiplying a raster by a
constant, or removing a predetermined “null” value.

For this example, you have learned that the rainfall data collected from the rain gauges had a
common discrepancy. Each gauge misrepresented the rainfall amount by two inches uniformly
across the state. There are several ways you could approach this problem, but you will add two
inches uniformly across the interpolated rain raster to practice using the raster calculator.

1. In ArcToolbox, in the Spatial Analyst Tools toolbox, double-click Map Algebra >
Raster Calculator.
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2. Under 'Layers and variables’, double-click the IDW_Rain layer. (You may need to
stretch the ‘Raster Calculator’ window to be wider to see all options.)

3. Click the + 2 (plus two) buttons.

4. For ‘Output raster’, rename the exported raster from “rastercalc” to
“IDW_Rain_2".

5. Ensure your ‘Raster Calculator’ window looks like that shown below and click OK.

=
Map Algebra expression _I
Layers and variables Conditional -
<& TNRast_wind 7l3|g| ;I..|!.|altm
<> TINRast_Rain Pick
<> NN_Rain 41s |6 =|>|>=]| 1 ||setwul
<> spline_Rain
<>ID W Rain 1 2 3 - < | <= ~ Math
RSN Y e -

"IDW_Rain" + 2

Output raster
[ C:\Users\gistrain\Desktop\InterpolatonTutorialData\HurricaneData.gdb\IDW _Rain_2 @ .LI

[ ok | caxcel | Envionments...| showrep>> |

The new raster will be added to the map.
6. Inthe Table of Contents, check the IDW_Rain layer to turn it on.
7. On the Tools toolbar, click the Identify tool.
8. Inthe Map Display, click anywhere within the raster layer.

9. In the ‘ldentify’ window, use the ‘Identify from:’ drop-down box to select <Visible
layers>.

10. Again, in the Map Display, click anywhere within the raster layer.

In the “Identify’ window, notice that the value of the IDW_Rain_2 raster is approximately two
greater than the value of the IDW_Rain raster. Click a few more points to confirm this is true
across the raster.

You have now learned multiple methods of interpolating point and line data into raster data and
extracting raster data at point locations. You have also reviewed skills from other short courses,
including mapping XY data.

Last updated 10/16/12
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